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QUESTION 1
SMB is also called _____________.

A. CIFS

B. VPN

C. VNC

D. AFP

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 2
You are setting up Time Machine on your Mac. Where can Time Machine store its backup files?

A. iCloud

B. DVD-R disc

C. external USB hard disk

D. internal startup volume

Correct Answer: C
Explanation

Explanation/Reference:
Explanation:

QUESTION 3
In OS X Mountain Lion, which of these can you use to set a firmware password?

A. The Users & Groups pane of System Preferences

B. The Security pane of System Preferences

C. The Firmware Password utility in /System/Library/CoreServices/

D. The Firmware Password utility on the Recovery partition

Correct Answer: D
Explanation

Explanation/Reference:
Explanation:

QUESTION 4
What is SMTP's role in email transactions?

A. SMTP transfers outgoing email from the sender's mail server to the recipient's mail server.

B. SMTP provides the mail server with user account information, including the user ID and email address
for arequested user account.

C. SMTP translates IP addresses into domain names, and vice versa.

D. SMTP transfers incoming email from the recipient's mail server to the recipient's local mailbox.

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:
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QUESTION 5
On a Mac, you are adding a new Mail account that will access an Exchange server. The server has
Autodiscover enabled. What is the minimum information you need in order to add the account?

A. the Exchange email address and password

B. the Exchange email address and password, and the Exchange Server IP address or domain name

C. the Exchange email address and password, the Exchange Server IP address or domain name, and the
Exchangeserver admin account name

D. the Exchange email address

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 6
Which protocol does OS X use to print to a printer shared by a Windows computer?

A. PPTP

B. L2TP

C. LPD

D. SMB

Correct Answer: C
Explanation

Explanation/Reference:
Explanation:

QUESTION 7
In addition to Mail, which THREE other applications can you use to set up a new account to access a
Microsoft Exchange Server? (Select 3)

A. System Preferences

B. Messages

C. Contacts

D. Keychain Access

E. Directory Utility

F. Calendar

Correct Answer: ACF
Explanation

Explanation/Reference:
Explanation:

QUESTION 8
Which messaging protocol does Messages in OS X Mountain Lion support?

A. IRC

B. MSNP

C. SMS

D. XMPP

Correct Answer: D
Explanation
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Explanation/Reference:
Explanation:

QUESTION 9
Review the screenshot, and then answer the question below.

You try to open an application called Dead End, but you get the alert shown above. You know the
application comes from a trusted source. How can you open the Dead End application?

A. Control-click the application, choose Open from the shortcut menu, and then click Open in the dialog
that appears.

B. Option-click the application.

C. Open Security & Privacy preferences, click the Gatekeeper tab, click the Add (+) button beneath the
AuthorizedApplications list, and enter "Dead End."

D. Open Security & Privacy preferences, click the Gatekeeper tab, click the Add (+) button beneath the
Developers list,and enter "Houdini."

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 10
The SMB protocol is used to _____________.

A. establish video conferences between users of the Messages application

B. share screens between Mac users

C. send email messages from Windows computers

D. provide Windows users access to shared files

Correct Answer: D
Explanation

Explanation/Reference:
Explanation:

QUESTION 11
You configured a Mac with OS X Mountain Lion to share its connected USB printer over the network. Why
might a Windows user be unable to print to the shared printer?

A. The printer needs to be selected in the Print Sharing control panel on the Windows computer.

B. The Windows computer hasn't been upgraded with the appropriate Service Pack.

C. Apple Print Services for Windows hasn't been installed on the Windows computer.

D. OS X Mountain Lion doesn't support sharing printers with Windows computers.
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Correct Answer: D
Explanation

Explanation/Reference:
Explanation:

QUESTION 12
In order to bind your Mac to your company's Active Directory server, you will need to enter the address of
the Active Directory Domain, and _____________.

A. the domain name associated with your Mac

B. the Ethernet ID of your Mac

C. an Active Directory admin user name and password

D. your e-mail address

Correct Answer: C
Explanation

Explanation/Reference:
Explanation:

QUESTION 13
You want to migrate documents from a Windows computer to a new MacBook using Migration Assistant.
Which step will prepare for that migration?

A. Connect an external hard drive to the Windows computer.

B. Connect both computers to the same network.

C. Connect the MacBook and the Windows computer to one another using a USB cable.

D. Start up the MacBook in target disk mode and connect the computers with a USB cable.

Correct Answer: B
Explanation

Explanation/Reference:
Explanation:

QUESTION 14
A default installation of OS X supports VPN over which THREE protocols? (Select 3 responses.)

A. SMTP

B. MPLS

C. LDAP

D. PPTP

E. L2TP over IPsec

F. VPNP

G. Cisco IPsec

Correct Answer: DEG
Explanation

Explanation/Reference:
Explanation:

QUESTION 15
A MacBook Pro with Retina display has an unknown firmware password. How can you reset the
password?

A. Take the MacBook Pro to an Apple Retail Store or Apple Authorized Service Provider.
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B. Start up the MacBook Pro from the Recovery Disk and choose Reset Firmware Password from the
Utilities menu.

C. Turn off the MacBook Pro, open it and change the configuration of its physical memory modules, then
close it andturn it on again.

D. Start up the MacBook Pro and click Enter Master Password at the login window. Enter the computer's
masterpassword, and click Reset Firmware Password.

E. In System Preferences, click Start Up Disk, authenticate with an administrator account password, and
click ResetFirmware Password.

Correct Answer: B
Explanation

Explanation/Reference:
Explanation:

QUESTION 16
Two days ago you connected a new USB hard drive to your Mac. Which procedure will configure Time
Machine to back up your data to the USB drive?

A. Drag the USB hard disk icon from the desktop onto the Time Machine icon in the Dock.

B. Click the Time Machine icon in the Dock, select the new USB hard disk as the backup destination,
choose ZIP fromthe Backup Format list, and click Start.

C. In System Preferences, click Time Machine, then click Select Disk, select the USB hard disk, and click
"Use forBackup."

D. Drag the USB hard disk icon from the desktop onto the Time Machine icon in the /Applications/Utilities/
folder.

Correct Answer: C
Explanation

Explanation/Reference:
Explanation:

QUESTION 17
Which files on a Mac does Time Machine, in its default configuration, NOT back up?

A. Applications

B. Files in ~/Sites/

C. Fonts installed in /Library/

D. Documents that you manually copied to the Time Machine volume

Correct Answer: D
Explanation

Explanation/Reference:
Explanation:

QUESTION 18
Which password was generated by choosing "Letters & Numbers" from the Type menu in Password
Assistant?

A. mBOLq9dWSMLE

B. 741632465697

C. *90CJTLZ-oR'

D. chap5\soiree

Correct Answer: A
Explanation
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Explanation/Reference:
Explanation:

QUESTION 19
You are using the Mail assistant on your Mac to add a Mail account that will access email from an
Exchange account. Which TWO other types of data can you simultaneously configure OS X to access?
(Select 2 responses.)

A. System keychains

B. Contacts

C. Browser bookmarks

D. Instant messaging accounts

E. Calendars

F. Network user accounts

Correct Answer: BE
Explanation

Explanation/Reference:
Explanation:

QUESTION 20
From your Mac, you want to access mail, calendars, and contacts served by a Microsoft Exchange Server.
What is the earliest version of Exchange Server for which Mountain Lion provides built-in support for this
task?

A. Microsoft Exchange Server 2000 with Service Pack 4

B. Microsoft Exchange Server 2007 with Service Pack 1 Update Rollup 4

C. Microsoft Exchange Server 2003

D. Microsoft Exchange Server 2010

E. Microsoft Exchange Server 2003 with Service Pack 2

Correct Answer: D
Explanation

Explanation/Reference:
Explanation:

QUESTION 21
Which statement about Messages is true?

A. Without installing any additional software, Messages can be configured to use a Google Talk account.

B. Messages requires users to have an Apple ID account.

C. Without installing any additional software, Messages can be configured to use a Microsoft Live
Messenger Talkaccount.

D. If a Mac user using Messages wants to exchange instant messages with a Windows user, the Windows
user mustinstall the Messages application.

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 22
Using the Finder's "Connect to Server" command on your Mac, you try to connect to a Windows file server,
but receive an error message that there was a problem connecting. Which statement presents the most
likely cause of this problem?
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A. You must type "smb://" before the server address in the "Connect to Server" dialog to access a
Windows file server.

B. It is not possible to access a Windows file server using the "Connect to Server" command.

C. You must install Boot Camp on your Mac to access a Windows file server using the "Connect to
Server" command.

D. You must turn on Windows Support in the Sharing pane of System Preferences to access a Windows
file serverusing the "Connect to Server" command.

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 23
In the context of computers on a network, what does "bind" mean?

A. Configure a computer to use a network account server.

B. Configure a computer to connect to a network.

C. Configure a computer to prevent it from accessing data on the network.

D. Configure a firewall on a computer to restrict inbound traffic.

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 24
Which of these provides directory and authentication services for Windows Server?

A. Active Directory

B. Exchange Directory

C. Open Directory

D. LDAP Directory

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 25
What happens if you select "Block all incoming connections" in the Firewall service options in OS X?

A. Files on your Mac that are shared using Personal File Sharing will be inaccessible to users on the
network.

B. The Mail application on your Mac will no longer receive incoming messages from a mail server.

C. File servers on your local network will not be visible in the Finder's network browser.

D. Your Mac will NOT be able to obtain an IP address from a DHCP server.

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 26
Which statement accurately describes the function of FileVault 2?
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A. It keeps a journal that tracks all changes to a user's files.

B. It encrypts a disk's contents.

C. It backs up a user's data to a specified volume on a specified schedule.

D. It stores a user's home folder as an encrypted disk image.

Correct Answer: B
Explanation

Explanation/Reference:
Explanation:

QUESTION 27
Review the screenshot, and then answer the question below.

You have a Mac with the user accounts shown in the screenshot above. You want to configure the Mac to
connect to an Active Directory server. In order to perform the configuration, you must authenticate as
_____________.

A. Chris

B. Bob

C. Sam

D. Pat

Correct Answer: C
Explanation

Explanation/Reference:
Explanation:

QUESTION 28
Diego wants to run a Windows-based application on a MacBook Pro. What is a valid reason for him to use
Boot Camp to do so, rather than a virtual solution like Parallels or VMWare Fusion?

A. Boot Camp lets Diego switch between OS X and Windows applications instantly, whereas virtual
solutions requireDiego to restart his MacBook Pro in order to switch between the two environments and
their applications.

B. Boot Camp does NOT require Diego to buy and install Windows in order to run Windows-based
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applications,whereas virtual solutions do.

C. Diego can buy Boot Camp on the App Store for $9.99, which is less expensive than the virtual
solutions.

D. Boot Camp runs natively without hardware-resource contention on Mac computers, so Diego will see
better overallperformance with Boot Camp than with virtual solutions.

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 29
Which protocol CANNOT be used to print from a Mac with OS X Mountain Lion to a network printer?

A. AppleTalk

B. SMB

C. IPP

D. HP JetDirect

E. LPD

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 30
What is the role of Bonjour in the Messages application?

A. To discover other Messages users on the local network

B. To communicate with AIM chat accounts

C. To communicate with GoogleTalk accounts

D. To stream video between Messages users

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 31
You are using Boot Camp to install Windows on your OS X Mountain Lion Mac. You will need an
installation disc for _____________.

A. Windows 7 or later

B. Windows Vista or later

C. Windows XP or later

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 32
Moments ago you connected a new FireWire hard drive to your Mac. Which procedure will configure Time
Machine to back up your data to the FireWire drive?
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A. Click "Use as a Backup Disk" in the Time Machine alert dialog that appears when you connect the
FireWire harddrive.

B. Drag the new FireWire hard disk icon from the desktop onto the Time Machine application icon in the /
Applications/Utilities/ folder.

C. Open Time Machine, select the new FireWire hard disk as the back up destination, choose ZIP from
the BackupFormat list, and click Start.

D. Drag your home folder to the new FireWire hard disk icon on the desktop.

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 33
You configured a Mac to print to a network printer that has a duplex unit. When you choose Print, the Print
dialog does not display the two-sided printing option. To enable two-sided printing, you must
_____________.

A. choose Print from the File menu, choose Printer Features from the Print Options pop-up menu, and
then selectDuplex Printing Unit in the pane on the left

B. open Print & Scan preferences, select the printer, and then select Duplex Printing Unit in the pane on
the left

C. choose Page Setup from the File menu, choose the printer from the Printer pop-up menu, then select
DuplexPrinting Unit

D. open Print & Scan preferences, select the printer, click Options & Supplies, click Driver, and then select
DuplexPrinting Unit

Correct Answer: D
Explanation

Explanation/Reference:
Explanation:

QUESTION 34
In OS X, the "Connect to Server" command in the Finder supports which TWO of these network file
protocols? (Select up to 2 responses.)

A. P2PP

B. NCP

C. AFP

D. FTP

E. ADC

Correct Answer: CD
Explanation

Explanation/Reference:
Explanation:

QUESTION 35
You are using Boot Camp to install Windows on a Mac. In addition to a Windows installation disc, you need
a(n) _____________.

A. OS X Mountain Lion installation disc

B. PC with Windows 7 installed

C. blank CD or DVD, or external drive formatted as MS-DOS

D. UFS-formatted partition on the Mac
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Correct Answer: C
Explanation

Explanation/Reference:
Explanation:

QUESTION 36
You have installed Boot Camp and Windows on your Mac. Which OS X System Preferences pane lets you
set up the Mac to boot into Windows by default?

A. Users & Groups (Login Items tab)

B. Accessibility

C. Boot Camp

D. Startup Disk

Correct Answer: D
Explanation

Explanation/Reference:
Explanation:

QUESTION 37
Review the screenshot, and then answer the question below.

Using the interface shown in the screenshot above, how can you make a Mac generate a random
password for you?

A. Click the Key icon to launch Password Assistant, and choose Random from the Type pop-up menu.

B. Control-click in the New Password field, and choose Random from the New pop-up menu.

C. Click the Change Password button, and choose Random from the New pop-up menu.

D. Option-click in the New Password field, and choose Random from the New pop-up menu.

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 38
You have installed Boot Camp and Windows on your Mac. Which Windows tool lets you set up the Mac to
boot into OS X by default?

A. Boot Camp utility
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B. Windows Boot Camp control panel

C. Mac OS Startup utility

D. Windows Startup control panel

Correct Answer: B
Explanation

Explanation/Reference:
Explanation:

QUESTION 39
What Windows Server technology provides directory and authentication services?

A. Exchange Directory

B. LDAP Directory

C. Active Directory

D. Open Directory

Correct Answer: C
Explanation

Explanation/Reference:
References:

QUESTION 40
Which statement about iChat is true?

A. iChat can be configured to use a Google Talk account.

B. In order for a Mac user to use iChat to exchange instant messages with a Windows user, the Windows
user must install iChat.

C. iChat can be configured to use a Microsoft Live Messenger account.

D. iChat requires users to have an Apple ID account.

Correct Answer: A
Explanation

Explanation/Reference:
Explanation:

QUESTION 41
In OS X Lion, where can you set the firmware password?

A. In the Firmware Password utility in the Utilities folder

B. In the Users & Groups pane of System Preferences

C. In the Firmware Password utility, after booting from the Recovery partition

D. In the Security pane of System Preferences

Correct Answer: C
Explanation

Explanation/Reference:
References:

QUESTION 42
You are NOT able to access a Windows file server using your OS X computer's "Connect to Server"
command. What is a possible cause of this problem?

A. You need to select the "Windows support" option in the Sharing pane of System Preferences before
accessing a Windows file server.
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B. You need to prefix the Windows server address with "smb://" in the "Connect to Server" dialog.

C. It is NOT possible to access Windows file servers using the "Connect to Server" command.

D. You need to install Boot Camp on your OS X computer before accessing a Windows file server.

Correct Answer: B
Explanation

Explanation/Reference:
References:

QUESTION 43
What is POP's role in email transactions?

A. It lets mail clients retrieve email from the mail server.

B. It transfers outgoing email from the sender's mail server to the recipient's mail server.

C. It translates IP addresses into domain names, and vice versa

D. It provides user account information, including the email address associated with a particular user
account.

Correct Answer: A
Explanation

Explanation/Reference:
References:

QUESTION 44
In the context of computers on a network, what does "bind" mean?

A. Configure a computer to connect to a network account server.

B. Configure a firewall on a computer to restrict inbound traffic

C. Remove data from a hard disk so that the computer can be recycle

D. Restrict access to the files on a local hard disk.

E. Configure a computer to prevent it from accessing data on the network.

Correct Answer: A
Explanation

Explanation/Reference:
References:

QUESTION 45
You have a Mac Pro with an unknown firmware password How can you reset the password?

A. Start up the Mac Pro from the Recovery volume and choose Reset Firmware Password from the
Utilities menu.

B. Start up the Mac Pro and click Enter Master Password at the login window. Enter the computer's
master password, and click Reset Firmware Password

C. In System Preferences, click Start Up Disk, authenticate with an administrator account password, and
click Reset Firmware Password

D. Turn off the Mac Pro, open it and change the configuration of its physical memory modules, then close
it and turn it on again.

Correct Answer: D
Explanation

Explanation/Reference:
References:

QUESTION 46
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